This document is designed to help users become familiar with the Standard & Poor’s Research Insight software and the Compustat North America database. Consider the information contained herein to be a starting point. Current subscribers may copy this document for internal use only. More complete documentation may be found both within the software and in the manual set (Getting Started, Beyond Basics, Report and Chart Library, and Data Guide) supplied with your subscription. Additional manuals may be ordered by contacting Standard & Poor’s Investment Services Customer Support at 800-523-4534.

All information and data provided through university subscriptions is restricted to academic use only.
# Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview</strong></td>
<td>2</td>
</tr>
<tr>
<td>Population and Pre-defined Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Research Insight Help Features</strong></td>
<td>3</td>
</tr>
<tr>
<td>Help Menu (including software demo)</td>
<td></td>
</tr>
<tr>
<td>Look Up Tool</td>
<td></td>
</tr>
<tr>
<td><strong>Understanding Time Periods</strong></td>
<td>5</td>
</tr>
<tr>
<td>Current Period</td>
<td></td>
</tr>
<tr>
<td>Setting the cutoffs (very important for faculty &amp; research!)</td>
<td></td>
</tr>
<tr>
<td><strong>Time Period References</strong></td>
<td>6</td>
</tr>
<tr>
<td>Absolute, Relative and Calendar time referencing</td>
<td></td>
</tr>
<tr>
<td>Specifying in Reports, Screens and Formulas</td>
<td></td>
</tr>
<tr>
<td><strong>Functions Overview</strong></td>
<td>8</td>
</tr>
<tr>
<td>Multiple Regression</td>
<td></td>
</tr>
<tr>
<td>Calculating Statistics Across Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Formulas Overview</strong></td>
<td>9</td>
</tr>
<tr>
<td>Formula Examples (examples of logic and syntax)</td>
<td></td>
</tr>
<tr>
<td><strong>Screening Overview</strong></td>
<td>11</td>
</tr>
<tr>
<td>Defining Criteria</td>
<td></td>
</tr>
<tr>
<td>Viewing Results and Saving Sets</td>
<td></td>
</tr>
<tr>
<td><strong>Importing Company Sets</strong></td>
<td>12</td>
</tr>
<tr>
<td><strong>Report Overview</strong> (Generating Data)</td>
<td>13</td>
</tr>
<tr>
<td>Pre-Defined Reports (Now including Pre-defined panel reports for SAS/SPSS-type formats!)</td>
<td></td>
</tr>
<tr>
<td>Exporting/Saving</td>
<td></td>
</tr>
<tr>
<td>Accessing in Microsoft Excel®</td>
<td></td>
</tr>
<tr>
<td>Sector &amp; Industry Reports</td>
<td></td>
</tr>
<tr>
<td>Creating Reports / Report Assistant</td>
<td></td>
</tr>
<tr>
<td>Creating Panel Reports for SAS (important for faculty &amp; research!)</td>
<td></td>
</tr>
<tr>
<td>Charts</td>
<td></td>
</tr>
<tr>
<td><strong>Sample Applications</strong> - Putting it all together</td>
<td>22</td>
</tr>
<tr>
<td>Bankruptcy Event Study, Backtesting, ZSCORE and DUPONT models</td>
<td></td>
</tr>
</tbody>
</table>

THE “Θ” SYMBOL AT THE BOTTOM OF EACH PAGE PROVIDES A LINK BACK TO THIS TABLE OF CONTENTS

---

Standard & Poor’s Investment Services Corporate Headquarters
7400 South Alton Court
Englewood, CO 80112
U.S. & Canadian Clients: 800-525-8640
Fax: 303-721-4677
International Clients:+44 181543-2555
Copyright© 2003 The McGraw-Hill Companies, Inc.

Standard & Poor’s
A Division of The McGraw-Hill Companies
Overview

Welcome to Standard & Poor’s Research Insight!

Standard & Poor’s Investment Services, a division of The McGraw-Hill Companies, produces a variety of software and database products for institutional, financial, corporate and academic clients. Research Insight is a powerful yet easy-to-use graphical interface to the renowned Standard & Poor’s COMPSTAT database(s). The sophisticated software provides faculty, staff and students an efficient means of conducting research via data queries, retrieval, manipulation and analysis. Additionally, graduates will find that money managers, investment banks, consulting and accounting firms, government agencies and corporations use Standard & Poor’s Institutional Market Services data and software commercially in general. Experience with Research Insight could help secure internships or employment for many students and graduates.

The Compustat North America database contains fundamental financial, statistical, and market data for U.S. and Canadian corporations, banks, S&L’s, ADR’s/ADS’s, business segments, geographic areas, industry composites and indexes. Extensive coverage of annual and quarterly Income Statement, Balance Sheet, Cash Flow and supplemental data items is provided on publicly held companies.

Compustat North America data is derived from publicly traded companies and closed-end funds trading on the NYSE, AMEX, NASDAQ, OTC and Canadian stock exchanges, and wholly-owned subsidiaries of companies that are required to file with the SEC. Because companies present their financial results in a variety of formats, it is sometimes difficult to make accurate company comparisons on an "apples-to-apples" basis. That's why Standard & Poor's COMPUSTAT data includes the added value of data standardization. Our celebrated standardization process speeds and enhances your analysis by removing reporting variability and bias and assuring that the data you see is consistently collected and presented. Compustat North America data is collected according to detailed guidelines aligned with the regulations and standards of the Financial Accounting Standards Board (FASB), SEC and U.S. Generally Accepted Accounting Principals and Procedures (GAAP).

Throughout this document look for the symbol “◊◊”, which is used to identify tips or information of particular interest to users.

Research Insight may be used for advanced quantitative analysis, including database queries, or for quick access to company/industry financial statements and data. To easily generate data using pre-defined reports, please refer to page 13 of this primer.

- Population and Pre-defined Sets

Research Insight has many different predefined “sets” of companies, referred to as dollar sign ( $ ) sets. Examples of available “pre-defined” $ sets for the COMPUSTAT (North American) database are:

<table>
<thead>
<tr>
<th>$ Set</th>
<th>Description</th>
<th>What it contains...</th>
</tr>
</thead>
<tbody>
<tr>
<td>$C</td>
<td>CS Active</td>
<td>Active U.S. company data</td>
</tr>
<tr>
<td>$R</td>
<td>CS Research</td>
<td>Inactive U.S. company data</td>
</tr>
<tr>
<td>$T</td>
<td>Canadian</td>
<td>Active Canadian company data displayed in Canadian currency</td>
</tr>
<tr>
<td>$I</td>
<td>CS Indexes -</td>
<td>Active and Research Market data for active and inactive indexes</td>
</tr>
<tr>
<td>$CS</td>
<td>CS Business Segment</td>
<td>Business Segment data for active U.S. companies</td>
</tr>
<tr>
<td>$CG</td>
<td>CS Geographic Segment</td>
<td>Geographic Segment data for active U.S. companies</td>
</tr>
<tr>
<td>$CI</td>
<td>CS Active Issue</td>
<td>Issue data for active U.S. companies</td>
</tr>
<tr>
<td>$II</td>
<td>CS Index Issue</td>
<td>Index data for stock issues</td>
</tr>
<tr>
<td>$RI</td>
<td>CS Research Issue</td>
<td>Issue data for inactive U.S. companies</td>
</tr>
<tr>
<td>$TI</td>
<td>Canadian Issue</td>
<td>Issue data for active Canadian companies</td>
</tr>
<tr>
<td>$R1000</td>
<td>Russell 1000 Index</td>
<td>Contains U.S. companies with market values over $300 million</td>
</tr>
<tr>
<td>$R3000</td>
<td>Russell 3000 Index</td>
<td>Includes the 3000 most actively traded U.S. stocks</td>
</tr>
<tr>
<td>$SP_100</td>
<td>S&amp;P 100 Index</td>
<td>All companies in the S&amp;P 100 Index</td>
</tr>
<tr>
<td>$SP_500</td>
<td>S&amp;P 500 Index</td>
<td>All companies in the S&amp;P 500 Index</td>
</tr>
<tr>
<td>$SP_Ind</td>
<td>S&amp;P Industrials Index</td>
<td>All companies in the S&amp;P Industrials Index</td>
</tr>
<tr>
<td>$SP_Mid</td>
<td>S&amp;P MidCap 400 Index</td>
<td>All companies in the S&amp;P MidCap 400 Index</td>
</tr>
<tr>
<td>$SP_Small</td>
<td>S&amp;P SmallCap 600 Index</td>
<td>All companies in the S&amp;P SmallCap 600 Index</td>
</tr>
<tr>
<td>$SP_Super</td>
<td>S&amp;P 1500 Super Composite Index</td>
<td>All companies in the S&amp;P Super Composite Index. The Super Composite Index is comprised of the S&amp;P 500, S&amp;P MidCap400, and the S&amp;P SmallCap 600 Indexes</td>
</tr>
<tr>
<td>SADR</td>
<td>ADR</td>
<td>Companies that trade American Depository Receipts/Shares</td>
</tr>
</tbody>
</table>
Research Insight Help Features

Take a minute to get acquainted with the Research Insight Help Menu (available via the HELP/Research Insight Help Topics menu option), learn how Help is organized, and discover some tips and short cuts to make your tasks easier.

- The Research Insight Help Menu

  Research Insight Help Topics
  Includes the Table of Contents, an Index, and Find (lets you search for a topic).

  Data and Reference Definitions

  Data Item Definitions
  Displays item and concept definitions for the selected database (North America)

  Reference
  For Compustat North America topics include:
  Data Item Lists; Economic and Industry Sectors; Geographic Codes; Function Calculations; Indexes; SIC Codes; Restated Data Policy

  FAQ’s
  A list of the most Frequently Asked Questions about Research Insight, including specific examples on screening, reporting, formulas and other applications...very helpful!

  Each of the help sub-topics listed above include the following features, or “tabs”:

  - Contents Tab
    Works like a table of contents, displaying a list of available topics in on-line Help.
  - Index Tab
    Lets you search the index for a topic.
  - Find Tab
    Lets you perform a full-text search for a word or phrase...extremely useful!

Software Demo
A basic demonstration of the Research and Report Assistant features of Research Insight. More detailed instructions regarding these features are provided later in this document in the “Screening Overview” and “Report Overview” sections.

Other Compustat Products
Provides you with a complete list of Standard & Poor’s Investment Services products

Welcome to Research Insight
Opens the Welcome Window, which links you to the main functions of Research Insight, including the innovative and user-friendly “Wizards”. The Research Assistant wizard allows you to search (screen) the COMPUSTAT databases for companies that meet specific criteria. The Report and Chart Assistant wizards allow you to create custom reports and charts.

About Research Insight
Displays version and copyright information for the Research Insight.

Research Insight also allows you to Bookmark and Annotate help topics and definitions. These features can be very helpful and are accessed, respectively, by the menu options Bookmark/Define... or Edit/Annotate....

Additional help is available in Research Insight via the Look Up Tool, detailed further in the section that follows.
The Look Up Tool is accessed via the menu option **Tools/Look Up...**, via the toolbar button or via a Look Up button within various dialogue boxes. The Look Up Tool provides users with the ability, when needed, to “look up” various items, concepts, functions and companies used in Research Insight. Select one of the tabs in the Look Up Tool to view lists of Companies, Items and Concepts, Functions, or Sets. The number of tabs displayed will vary, depending on where you are in the software. For example, in Step 1 of the Research Assistant, the Look Up Tool only displays the Company tab since the program is expecting a company identifier in the input box.

To search for a company within the Look Up Tool:

Use prefix search by typing the beginning characters of the name you want to find in the Select Companies (or Select Items) field. You can enter a text string in the Find Text field and Research Insight will display the first name it finds that contains the string anywhere within the name of a company, item or concept, function, or set. Click the Find Next button to find additional occurrences of that text string. **Be sure to specify/note which “Company Category” you are accessing** (i.e. SC CS Active, $R CS Research, etc.).

For example, suppose you want to add American Bio Medica Corp., to your screening criteria in the Research Assistant:

1. Beginning in the Look Up Tool, type American Bio in the Select Companies text box. American Bio Medica Corp. is highlighted in the list box, and its ticker symbol (ABMC) appears below the list box.

2. Click the Paste button. The Look Up Tool pastes the ticker symbol into the Companies text box in the Assistant window.

3. Click Close to return to the Assistant window.

◊◊ Note that you can “bookmark” frequently used data definitions as well as help topics and functions.
Understanding Time Periods

- About the current period . . .

The current period changes each time data is updated for a new year, quarter, month, or day. Since companies have different fiscal years and reporting time frames, the current period differs among companies. If you do not reference a time period in your applications, you could evaluate formulas for a set of companies with different time periods, especially if you are using both Active and Research companies. To avoid this, include an “absolute” time period reference in the formula or specify the time period when you run a report or screen (see examples given on pages 6 and 17).

- Current Period Command - Options Menu

◊◊ Use this command to define the current period cutoff for annual, quarterly, monthly, weekly, and daily data. Since a company's current period depends on the last reported data of a company, you can direct Research Insight how far back in time data is considered current. This can be very important when screening the database, especially when accessing the research population! If you consider current annual data to be within the last five fiscal years, then enter the number 5 in the Annual box.

The example below shows how all cutoffs have been changed to the maximums for a typical academic subscription. Enter values to define current period settings for annual, quarterly, monthly, weekly, and daily time periods. The default values for these cutoffs are 3, 6, 6, 3 and 5 respectively.

◊◊ It is important to set these to the *maximums as shown above in order to be sure the software screens all available periods.

An example of how this can affect the results of screening for companies or data can be seen in the “Bankruptcy Event” application given later in this document. Leaving the cutoff for the Annual time period at the default of “3” results in the first line of the Bankruptcy Event screen returning only about half of the total companies which should pass the screen, instead of the over 700 companies which should result by setting to the *maximum of 20 as shown above. The reason for the apparent discrepancy is that the “additional” companies, most if not all of which are “research’ companies, have current periods beyond the three-year default setting. That is to say the only data available for these companies exists three or more years prior to the database default period (1999 as of this writing). A company that quit filing reports with the SEC in 1987 would have its most current data (i.e. current period) twelve years before the default period of 1999. The program would look for the existence of data in 1999, 1998 and 1997 and not look any further unless specifically told to via the settings above. For more specific information, refer to the following data items/mnemonics:

<table>
<thead>
<tr>
<th>Mnemonic</th>
<th>Data Item</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPD</td>
<td>Current Period</td>
<td>This item is presented as YY (for example, &quot;Y90&quot;)</td>
</tr>
<tr>
<td>CPDQ</td>
<td>Current Period – Quarterly</td>
<td>This item is presented as QQ/YY (for example, &quot;Q4Y90&quot;)</td>
</tr>
<tr>
<td>CPDM</td>
<td>Current Period – Monthly</td>
<td>This item is presented as MMM/YY (for example, &quot;Aug 88&quot;)</td>
</tr>
<tr>
<td>CPDW</td>
<td>Current Period Weekly</td>
<td>This item is presented as 26W90</td>
</tr>
<tr>
<td>CPDD</td>
<td>Current Period – Daily</td>
<td>This item is presented as 29 Jun 90</td>
</tr>
</tbody>
</table>

*maximums assume you are not accessing “Back Data” (an add-on subscription) beyond the twenty-year window
Time Period References

Time period references direct Research Insight to retrieve a data value for a particular point in time other than the current period. If you do not include time period references in your formulas, Research Insight automatically uses the current period (or the most recently available data).

There are three ways to specify the time periods: absolute, relative, and calendar, each of which are discussed below. The issue of Current Period Cutoffs on page 5 pertains primarily to “relative” time referencing. For example, if you are screening for SALE[Y90] > 100 the issue of cutoff is irrelevant since you are looking at an absolute date/time period of 1990. This is also true if you are using relative time referencing but actually running the screen for an absolute time period.

Fiscal years (defined as an accounting period of twelve months) ending in January through May are assigned to the calendar year in which that fiscal year begins. Fiscal years ending June through December are assigned to the calendar year in which the fiscal year ends. The calendar year for each company is the year in which the fiscal year ends. For example, if pulling the year-end data from 1991 to 1995 and one of the comparable company’s fiscal year ends in February, the data from February 1992 to February 1996 will be pulled for comparison. This is done to ensure the closest alignment of operating periods (see below). In this case, the company having the February fiscal year-end would overlap ten months of operating cycle with a December fiscal company for any given year. Also, balance sheet data is only two months off versus what would be ten months if based solely on calendar years.

- Absolute time period references

Absolute references direct Research Insight to an exact fiscal year, quarter, month, etc. If you use an absolute time period reference in a formula, then Research Insight will always evaluate the fiscal time period specified. Below are some examples of absolute time period references:

SALE[Y94]   SALEQ[Q2Y94]   PRCCM[AUG94]

- Relative time period references

Relative references direct Research Insight to evaluate formulas relative to the current time period. The current time period is 0, so the current time period reference is an implied [0]. Therefore, one period prior to the current period is indicated with [-1], two periods prior to the current period is indicated [-2], and so on. Below are some examples of relative time period references:

SALE[-1]   SALEQ[-3]   PRCCM[-4M]

- Calendar time period references

Calendar references direct Research Insight to an exact calendar year, quarter, month, week, or day. The calendar time period is always the exact year in which the time period ends.

For example, suppose a company's fiscal year-end is May 1997. The calendar time period for annual data is 1997, but the fiscal time period for the same company is different. If you evaluate monthly time periods for annual data ending May 1997, you'll see that seven of the 12 months are from the year 1996. Therefore, the fiscal time period for annual data is 1996. Below are some examples of calendar time period references:

Calendar Year   SALE[C97]   Calendar Quarter   SALEQ[IV97]
Calendar Month   PRCCM[JUN97]   Calendar Week   AJEXW[26W97]
Calendar Day   CSHTRD[28MAY97]

- Knowing when to use absolute, relative, or calendar time periods
Use relative time referencing to create more flexible formulas in your reports, screens, and spreadsheets. For example, suppose you create a monthly report that includes stock performance formulas for the past 12 months using relative referencing. When you evaluate the report, you can specify any beginning month. This gives you the flexibility to display the report for any time period without having to create another report. Use absolute or calendar referencing to always evaluate a formula for the same time period.

Time periods and periodicity are important in the alignment of data between companies, especially when exporting/saving data in columnar/table report formats. Gaining an understanding of these concepts helps to ensure efficient use of the Research Insight software and COMPUSTAT database(s).

- Specifying time periods when you run a report or screen

You may specify the time period for which you want your report evaluated, assuming that the report contains “relative” time references, by choosing the Select Period tab in the Run Assistant. For screening, in the Research Assistant you must choose the Classic View option in order to specify the time periods for which data is to be screened. If you do not invoke the Research Assistant for your screening, but choose the File and Classic View menu options you may “right-click” your mouse for the ability to “Run for Time Period”

You can specify more than one time period, depending on the type of data in your report or screen. For example, suppose you are evaluating monthly closing price and quarterly common equity. These two data types have different periodicities, monthly and quarterly. You can select a monthly and quarterly time period for the report or screen.

- Specifying time periods in formulas and Concepts

Time period references will always be contained within brackets “[ ]”, or will default to the “current” time period if no reference is specified. Always use brackets to specify time references and to enclose period functions when you are building free-form reports or when you are working in the Classic View window, as the following examples indicate:

```
SALE[Y96]  Returns fiscal 1996 - Sales - Net
(SALE + SALE[-1]) / 2  Returns the average of current and prior years’ Sales - Net
PRCCM[@MNT(-1Q)]  Returns the Monthly Close Price for the last month of the prior fiscal quarter
```

NOTE: If a formula is already referenced with an absolute time period (e.g., (SALE[Y94])), then that formula will always return data for the time period specified within brackets, even if you select a different time period when you run a report or screen.

One example of using time period referencing in formulas can be seen in a bankruptcy “event” application. The following “concept” (EVENTA) is designed to identify a specific event (bankruptcy) by screening for certain footnotes on the item “Assets- Total – Note” (ATF).

```
@period(0y)-@pmax(@if(@or(atf="ag",@or(atf="tl",atf="gl")),@period(0y),@period(-21y)),-19,0)
```

This logic uses relative time referencing to identify the most recent existence of an “ag”, “tl” or “gl” footnote on the annual balance sheet item “atf”. The @period functions allow for companies with differing fiscal years and business lifecycles to be screened with a single reference. The concept EVENTA can then be used as a time reference within a report, simply by replacing the existing relative references within that report. For example (ATF[-1], (ATF[-2]) become (ATF[-EVENTA] and (ATF[-EVENTA-1], etc. For more information on the bankruptcy event study and how to access such, please refer to page 22 of this document.

For additional information/examples see Getting Started, Chapter 8 - Understanding Periodicities

See also in online help:  @YR - Identify fiscal period year
@QTR - Identify fiscal period quarter
@MNT - Identify period month
@WK - Identify period week
@DAY - Identify period day

θ
Functions Overview

Functions are predefined calculation tools used to perform numerous tasks, from simply averaging data for an industry, to more sophisticated analyses using fractiles. Use functions in your screening, reporting, spreadsheet, and concept formulas individually, or combine them for more complex analysis. Research Insight provides you with more than 100 functions for historical, statistical, logical, growth and other analyses that allow you to easily and automatically perform data calculations and get complex results fast.

- **How to construct a function**

Every function begins with @, followed by a short name, such as CAVG. Additionally, each function requires instructions for what you want evaluated. We refer to these instructions as arguments and they are always enclosed in parentheses following the function name (i.e. @CAVG(NI,Y94,Y98) calculates average annual net income from 1994 to 1998).

Research Insight categorizes functions by the particular type of analysis you want to perform. A complete list of functions in each category, along with syntax and descriptions for each, are available by selecting the Functions tab in the Look Up tool.

- **Multiple Regression Functions**

These functions allow you to predict the value of a dependent variable (such as a company’s share price) based on its correlation over time with a number of independent variables (for example, Consumer Price Index, Housing Starts, and Price to Book). With the multiple regression functions, you can evaluate and compare the effects of up to 8 independent variables in a time series.

  - @MRALPHA Returns the intercept of the y-axis in the multiple regression equation
  - @MRBETA Returns the slope of the line for the specified variable
  - @MRTSTAT Indicates a statistically significant variable
  - @MRFSTAT Determines whether the observed relationship between the dependent/independent variables occurs by chance
  - @MRCORR Calculates the correlation coefficient between 3 or more items
  - @MRSTDERR Calculates the standard error of the desired variable

- **Set Analysis Functions - Calculating Statistics Across Sets**

While the Research Insight set analysis functions calculate statistics across sets of companies quickly and easily, you may want those statistics to be based on a company’s sector or SIC. Let’s say you want to compare companies in your current portfolio, but also want to compare them across industry sectors and against benchmarks such as the S&P 500. Research Insight makes it easy! All set analysis functions accept an optional parameter that you can use to base your calculations on and to enhance your analysis.

For example, if you want to create a report that compares the Return on Equity (ROE) for companies and then compare them to the S&P 500 and each company’s respective industry sector, you would use the following expressions in your report:

<table>
<thead>
<tr>
<th>Mneomic/Expression</th>
<th>Returns</th>
</tr>
</thead>
<tbody>
<tr>
<td>ROE</td>
<td>Company ROE</td>
</tr>
<tr>
<td>@CAVG(ROE, SSP_500)</td>
<td>Average ROE for S&amp;P 500 companies</td>
</tr>
<tr>
<td>@CAVG(ROE, SSP_500, SECTOR)</td>
<td>Average ROE for S&amp;P 500 companies in same sector as target company</td>
</tr>
</tbody>
</table>

The last expression calculates an average ROE using the S&P 500, but to base the average on each company’s sector. All of the set functions in Research Insight accept this new parameter. Research Insight uses this parameter to find other companies that have the same value. And, you can use any data item for this type of analysis. The options are virtually limitless!

- **Trimming outlying data points**

The functions @TRIMPCT and @TRIMSTD work with all Research Insight set functions, allowing you to narrow the scope of your search resulting in data that may be more meaningful to your financial analysis. The following expression instructs Research Insight to calculate an average ROE for the S&P 500, but to also trim off 1% of the high and low values:

  \[
  @CAVG(ROE, @SET(SSP_500, @TRIMPCT(ROE, 1)))
  \]

Related Topics in Research Insight: Set Analysis functions - Evaluate data across a set of companies or industries
Formulas Overview

Although the majority of your analysis can be performed through the Research Assistant, there may be times when you are building a custom report or chart or working in Research Insight’s Classic window when you will want to incorporate formulas and functions. A formula is a mathematical or logical combination of one or more items, concepts, functions, and operators that you can build to extract information from the database or perform a calculation. You can use formulas in Research Insight to create screen criteria, define data in your report or spreadsheet, add date labels to your report or spreadsheet, or create your own “concepts”. For a list of pre-defined concepts in Research Insight, see the Compustat North America Data Guide, Appendix - A, or use the Look Up Tool for Items under the category Concepts. Formulas often incorporate both time references and functions as previously described.

◊◊ Formulas may be saved as concepts and given a user-defined name or mnemonic. Concepts are saved to a “user database”, either locally or on your network. For more information regarding user databases please refer to chapters 10 and 11 in Beyond Basics.

• Formula Examples

This topic provides you with actual formulas you can create in Research Insight. These are just a sample of formulas that show various combinations of items, functions, parentheses, relational operators, company references, and time period references.

◊◊ You may also copy/cut formulas directly from examples given in data definitions or help files within Research Insight and paste them into your own formula, screen or report.

*Note that after copying some formulas you may need to delete spaces from within, or trailing, the formula. The spaces exist because the formulas are designed for readability, and will produce a “syntax error” when pasted to the formula cell.

• Formulas for Screens

*Note: The “$” symbol by itself represents a wildcard placeholder for a company set in the following examples. The formula will use the “base set” in screening or the set being run in a “table” report. This convention for specifying a set is restricted to screening and “table” reports only, not “Freeform” reports.

@AND(SPMIX<=60, TIC=TICI) *Note: Be sure to time reference SPMIX and use $CI+$RI if looking for historical data

Finds all issues in the SP500. The base set=$CI.

@CSIZE(@SET(@CHGCO(ISSUE), TSCI=0))

Screens for actively trading issues of stock.

@PSUM(@IF(NI>0, 1.0,0), y96, y01)=5

Sums a true/false condition...in this case whether Net Income is greater than zero at least five times between 1996 and 2001

• Formulas for Reports

SALE[@0Y-(@PCOUNT(SALE,-9,0))+1]

Looks back 10 years and uses sales reported at that time. If the company didn’t exist 10 years ago, use sales for the first year on file.

@RANK(ITEM*-1,$)

Reverses the order of @RANK.

@PSUM(DVPSXM, @MNT(0Y,12)+1, @MNT(0M))

Calculates year-to-date dividends on a calendar year basis.
Annualizes quarterly income statement data when all four quarters have not yet reported.

\[ @PSUM(SALEQ,Q1Y93,Q4Y93)*(4/(@PCOUNT(SALEQ,Q1Y93,Q4Y93)*1)) \]

Returns a 10-day average volume when one of the days is a holiday.

\[ @IF(@PCOUNT(CSHTRD,-9,0)=10, @PAVG(CSHTRD,-9,0), @PAVG(CSHTRD,-10,0)) \]

Calculates year-to-date EPS.

\[ @PSUM(EPSPXQ,0,3)[@IF(@AND(@PERIOD(0Q)=4,UPDQ=3),@QTR(-1Y)+1,@QTR(0Y)+1)] \]

Finds a company’s first year of data.

\[ @IF(@PERIOD(0Q)=1,SALEQ,@PSUM(SALEQ,-@PERIOD(0Q)+1,0)) \]

Calculates year-to-date values for the current period in free form reports.

- **Formulas for calculating decile rankings**

\[(1-@FRAC(CR,$MYSET))*10\]

Returns decimal values where the higher value decile is the best.

\[@INT((1-@FRAC(CR*1,$MYSET)*10)+1)\]

Returns integer values where the lower value decile is the best.

\[ @IF(@INT((1-(@FRAC(ITEM,$))*10)<10, @INT((1-(@FRAC(ITEM,$))*10)+1, @INT((1-(@FRAC(ITEM,$))*10)) \]

Calculates decile rankings in tables.

\[ @CMIN(XLR,@SET($SP_100, @NTILE(XLR,10,$SP_100)=1)) \]

Calculates bottom value/cutoff of the first decile based upon “Labor and Related Expenses” for the S&P 100. To calculate the top value for the decile, replace the @CMIN with @CMAX. To get a ranges of all deciles, use =2, =3, etc., to =10 with @CMIN and @CMAX.

- **Formulas for calculating industry/set relatives**

\[(DT/SEQ)/(@CSUM(DT,$SP_SUPER,SIC)/@CSUM(SEQ,$SP_SUPER,SIC))\]

When used in free form report, calculates company debt to equity ratio divided by aggregate debt to equity for all companies in the S&P Supercomposite index having the same SIC code as the company for which the report is run.

◊◊ Take advantage of the **Report/Define Name...** menu option to replace $SP_SUPER, or any set reference, with a prompt for a different base set, providing additional flexibility.

With a basic understanding of time periods, formulas and functions, we are ready to see how these are used in screening the database and generating reports.

**Related Topics in Research Insight:** Creating a formula  
Understanding time periods  
Mixing time periods  
Time period references
Screening Overview

Screening allows users to query the COMPUSTAT database(s) in order to create a set of companies for which data will be generated (see Importing Sets or Set Overview for alternate methods of creating sets). A default “style” is chosen during installation that dictates the items and parameters used by the Research Assistant. Other styles (i.e. Finance, Money Management, Transfer Pricing, or Credit) may be chosen or created using the Tools menu option, then choosing Options… and Styles. Additionally, styles may be modified within the Research Assistant – Step 1 window by using the Customize button.

• Defining Screening Criteria

◊◊ Users may create and run screens using either the Research Assistant or the Open Screen option from the side bar, or by selecting the File and Classic View menu options. The Classic View option is the most flexible in terms of saving and/or accessing interim subsets created as part of the screening process.

The Research Assistant provides an easy method of designing queries without having to know the syntax required for the formula(s). Right-clicking on the “Indicator Item” to be screened allows access to the definition and/or concept chosen. Once the screen has been defined and saved, you may use Open Screen and Classic View to modify it or gain access to subsets.

The “Classic View” facilitates saving or viewing multiple sets from within a single screen. For example to use the pre-defined Bankruptcy “Event” Screen (which screens for companies having been, or currently in, bankruptcy) and save each interim set you must open such using Open Screen and subsequently choosing the Classic View mode to open.

To screen, or query, the Compustat North America database using the Research Assistant “Wizard”, begin by defining your screening criteria in the Research Assistant - Step 1 window.

1) If your criteria relate to a particular company, enter the ticker symbol in the Companies box (separating tickers with commas).
2) To find related companies, choose one of the options under Find Similar Companies (or you can accept the default, Don’t Find Similar Companies).
3) Choose financial criteria from the tabs on the right. Each tab contains a set of related financial indicators. You can select as many indicators as you like for your screen by clicking the box next to the item name. (To de-select an indicator, click the box a second time to remove the check mark.)
4) Choose a mathematical symbol (e.g., <, or >) from the drop-down list. Enter a number or range related to the indicator in the far right field.
5) Choose the subset of the database that your screen will run against by clicking the Change Set button and selecting a set name from the drop-down list. Your screen will run against the set of all Active companies ($C) by default if no other set is chosen.
6) Click Next and Research Insight screens the database for companies that meet your criteria, and automatically proceeds to the next window where you can view the results of your screen.

• Viewing results and saving sets

After selecting criteria in Research Assistant - Step 1, click Next and you will see a list of the companies that met your screening criteria in the Company List box in Research Assistant - Step 2. If you are satisfied with the list as is, you can save these companies using the Save button to save a new set, or the Save As button to save the set with a new name leaving the original set intact.

To add a company to the list, enter its ticker symbol in the Add Company to set box, and click the Add Company button. To remove a company from the Company List, highlight the company name, and click the Remove Company button under the list. Research Insight keeps track of changes you make in the Added Companies and Removed Companies boxes on the right. To restore the original list of companies, click the Reset button in the center of the window.

There may be times when you want to save the screening criteria, or screen, associated with a particular report. For information on saving or associating a particular screen with a report, please refer to the section titled Screen Association on page 14 of this primer.

Another method of creating company sets is to import the company tickers or cusips from existing files, detailed in the next section.

Related Topics in Research Insight: How does Research Insight evaluate the criteria I choose?
Importing Company Sets

Importing sets of companies from an ASCII file into Research Insight is fast and easy! There are *two steps involved in importing your own sets: 1) creating your spreadsheet file and 2) importing the sets from your spreadsheet file into Research Insight.

*Note: Assumes that companies being imported are “known” to the system. If you import private companies, or those not in the population(s) of Research Insight, you would first have to define the company via the Databases and Company... menu options.

◊◊ A timesaving feature alerts you to “unrecognized” tickers, cusips or GVKEYS. When Research Insight encounters an unknown company identifier it will document such in an IMPORTXX.ERR file (XX signifying a number), while continuing to process those that are recognized. The file may be easily printed or SAVED PRIOR TO EXITING RESEARCH INSIGHT.

• Creating your spreadsheet

To create your spreadsheet file, open a new (or existing ) document in your spreadsheet software. Next create the table header, which must contain a retrieval key. Valid retrieval keys include:

- **TIC** The company’s ticker symbol.
- **CUSIP** The company’s CUSIP number.
- **GVKEY** The company’s GLOBAL Vantage Company Key, a permanent, non-changing key.

If you want to import a specific Issue, Business Segment, or Geographic Segment, type a backslash, the appropriate segment letter and two-digit segment identifier after the ticker symbol. For example, if you want to import the Domestic Geographic segment of the Mirage Hotel and Casino, you would use MIR\G01 as the ticker symbol.

We recommend that you save your file as a Comma Separated Values file (*.csv file). Close your spreadsheet application. You are ready to import your set into Research Insight.

• Importing your set

After creating a delimited text file, you are ready to import the set into Research Insight. Begin from the Import dialog box (from the File menu, select Import...):

1. Type the name of the file you want to import in the File Name: text box or select the file from the list box.
2. Select the Set radio button in the Import: text box and click Open, you will be prompted to confirm that the file is comma delimited, click on Yes (The Set Type dialog box appears).
3. Select the type of set that you want to import, normally just accept the default of Company, then Click OK.

NOTE: If your spreadsheet contains a company ticker, you can still import the company as a business segment set, a geographic segment set, or an issue set. The retrieval keys in the spreadsheet do not have to match the set type you choose.

A new window will briefly display an import progress bar, the type of retrieval key used, and the items being imported. Research Insight will tell you when the processing is complete. The imported set appears on your screen.

4. Save file as a set. From the File menu, select Save (You’ll see the Save File dialog box). Enter the set name in the File Name: text box. Click OK, Your file is saved as a set.

◊◊ You may also import data/concepts into a “user database”. Please refer to the Beyond Basics manual for more information.

Related Topics in Research Insight: Importing Data
Importing Concepts

Ω
Report Overview

Reports allow you to generate, view, print, and save/export data for a company or set of companies. You may also use “pre-defined” reports to copy formulas, cells, or entire sections into a new user-defined report, or to examine the logic used in creating formulas. Whether you create your own, or use one from the library of pre-defined reports, Research Insight makes it easy!

- Pre-defined reports

Research Insight contains a library of free form and table reports, including a variety of financial statements and comparative presentations. These reports supply you with common data presentations, so that you don't have to create a report from scratch. Of particular interest to researchers are the “Panel” reports included in the “Miscellaneous” folder (see below). Panel reports are designed and formatted specifically for exportation of data into SAS/SPSS-type file structures, facilitating uploading data into other statistical software packages. Learn more about creating and modifying your own panel reports on page 17…

◊◊ Pre-defined reports can also help users by providing a good source of formula/expression examples. If an existing report has the type of data you want, such as industry relatives or ratios, you can copy and/or modify the formula for your particular need. **Reports may also be pulled up directly into EXCEL, taking advantage of Active-X technology.** Once you have opened and run a report in EXCEL, simply use the S&P and Break Arrays menu commands, or the Unlink Arrays tool to save formulas as values! Running the reports directly in EXCEL alleviates the need to specify file “delimiters” when exporting directly from Research Insight and the potential need to realign data within the finished reports.

To access a pre-defined report, click **Open Report** in the Welcome window or sidebar, or the Open Report icon in the toolbar, and choose from the list of reports categorized by type.

The report template will appear, followed by the Run Assistant dialogue box prompting you for the company/set for which you need data. At this point you should:

1. Type the company ticker, or tickers separated by commas in the Companies box, or use the Change Set button to enter a set name in the Initial Sets dialog box. You can also use the @SET function to enter a set in the Initial Sets box. For more information, see Current and temporary sets.
2. Research Insight automatically runs the report for the current period unless you select a specific time period. To specify a time period, select the Report Time Periods tab in the Run Assistant. Use the arrow buttons to select appropriate periodicities.
3. To run the report, Click OK. Research Insight evaluates the report, then displays the report results.
4. To print the report, from the File menu, select Print and click OK.

• Screen Association

There may be times when you want to save the screening criteria, or screen, associated with a particular report. To save a particular screen with a report:

From the Tools menu, choose Options. Next, select the Report tab and, under Saving Reports, click the Save Screen association to reports check box. To turn off this option, click the check box again to remove the check mark.

What happens when I select this option? When you close a report, Research Insight will prompt you to save the screen, then the report. With this option selected, Research Insight automatically links the last screen you ran with the report. The next time you open this report, Research Insight will immediately run the report using the associated screening criteria.

What happens when I turn this option off? When you close a report, Research Insight will prompt you to save the screen, then the report. However, the software does not save a connection between the screen and the report. The next time you open this report, Research Insight opens the Run Assistant so you can select new screening criteria.

• Exporting/saving report results

The data in the report can also be saved to an ASCII file for use in other application software such as spreadsheet software. To save the data you have generated, begin from the report you have just run:

1. To export your report results, from the File menu, select Save As. You'll see the Save File dialog box.

2. Before saving the file, notice the Text Options... dialog box, which you can use to select column delimiters for your reports. The column delimiter you use depends on the software to which you want to export. The default is to use Tab delimiters, and Labels are not selected. To include labels with your export you must select such. For more information about specific delimiters required by your software program, refer to your specific software manual.

3. Type a file name and click Save (Note that in many universities, you may not have proper permissions to save to the network drive and must first re-direct the file using the Save in: option). The report results are saved with a .txt extension.

• Pre-defined Reports & Templates in Microsoft Excel®

One of the most powerful features of Standard & Poor’s Research Insight is its ability to communicate with other active software packages through Active-X technology. This technology allows almost instantaneous communication between Research Insight and Microsoft Excel®. Research Insight is compatible with Excel 97 or greater.

Note: You must turn off the Auto Correct feature in EXCEL to ensure you are retrieving data for the company you have specified. To do so, select Auto Correct from the Tools menu and deselect the Replace Text As You Type option.

◊◊ Users may also create or open existing Research Insight reports (pre-defined or user-defined) directly in Excel, eliminating the need to export data, by using the S&P add-in on the Excel menu. Begin with Excel open:

From the S&P menu, select the Open Report option, you will see the File Open window. Next, select the folder/report you wish to run, then click Finish. You will see the Run Assistant window. Enter your target companies’ ticker symbols in the Companies field, separating ticker symbols with commas (i.e. sbux, bean, f), or the set name. Finally, click OK, and you should see the requested data/report in Excel. To view the report for other companies, select the company from the drop-down list directly above the report. To modify the criteria used to create the spreadsheet, select Run Assistant from the S&P menu.

Although there is no need to export the data, the file actually contains formulas as opposed to raw data. You may save the EXCEL spreadsheet and the Active-X syntax will automatically be saved within the sheet. In order to save the data for use without Research Insight, (i.e. save the file for use at home) users can use the “Unlink Arrays” icon on the EXCEL toolbar or the S&P and Break Arrays menu options. Breaking the arrays produces an additional sheet within the EXCEL workbook containing data only, while maintaining the original sheet/report containing the formulas. This is a great way to learn the Research Insight/EXCEL syntax!
In addition to the reports listed in the Report Library, several useful templates have been created for use within EXCEL exclusively. These templates cannot be accessed from within Research Insight itself. Please refer to pages 27 and 28 of this primer for examples and more information on accessing these valuable tools.

- Sector & Industry Reports

Many clients have asked for quick and easy methods to get industry composite, or aggregate, data for sets that they have created. The following reports, located in the Sector and Industry Reports folder in the Report Library, were created to meet that need:

<table>
<thead>
<tr>
<th>FILE NAME</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>CBSCMPOS.RPT</td>
<td>Annual Balance Sheet for a User-Defined Set</td>
</tr>
<tr>
<td>CISCMPOS.RPT</td>
<td>Annual Income Statement for a User-Defined Set</td>
</tr>
<tr>
<td>CBSCMAVG.RPT</td>
<td>Average Annual Balance Sheet for a User-Defined Set</td>
</tr>
<tr>
<td>CISCMAVG.RPT</td>
<td>Average Annual Income Statement for a User-Defined Set</td>
</tr>
<tr>
<td>CRATAVG.RPT</td>
<td>Average Annual Ratio for a User-Defined Set</td>
</tr>
<tr>
<td>CSUMXIND.RPT</td>
<td>* Financial Summary (Including Industry Comparisons) - 5 Years</td>
</tr>
</tbody>
</table>

These files were designed to take advantage of the @CSUM, @CAVG and @CW AVG functions in Research Insight. The reports also take advantage of the * Report and Define Name... menu options in Research Insight, which prompts users for either company keys, formulas or, as is the case with these reports, sets. Please note that only the first two reports are true aggregations, as the other reports use averages and weighted averages as opposed to summations.

The first step in generating aggregate data is to run a screen to define your set (or composite). The example below shows a simple screen (in the Classic View) for companies having a 2000 sic code. Once the screen has been run, save the resulting set (i.e. sic2000) to be run for the specific report.

<table>
<thead>
<tr>
<th>Base Set</th>
<th>Size</th>
<th>Formula</th>
<th>Min</th>
<th>Max</th>
<th>Passed</th>
<th>Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 $C</td>
<td>10214</td>
<td>SIC</td>
<td>2000</td>
<td>2000</td>
<td>10</td>
<td>sic2000</td>
</tr>
<tr>
<td>2 $C</td>
<td>10214</td>
<td>SIC</td>
<td>2000</td>
<td>2000</td>
<td>10</td>
<td>sic2000</td>
</tr>
</tbody>
</table>

The next step is to open the report(s) of choice from within Research Insight and, if applicable, choose the date for which you wish to extract data. The date is chosen by selecting the Select Period in the Report Time Periods option in the Run Assistant dialogue box. You will automatically be prompted for such, and by default RI will return the most recent data available. All reports are designed to return five years of annual information, except the ratio report, which returns six years of information.

* Once the date has been selected, you should see the following Defined Names Prompt, for which you will enter your set name.

You may actually screen directly from the Input Set Name prompt using the @SET function (i.e. @SET($C,SIC=2000), but this will not allow you to save the set for future use. Also, you may choose to modify the reports for other statistical purposes. For instance you may use the Edit/Replace menu options to replace the @CSUM with @CMED to get medians rather than aggregates.
• **Creating your own reports**

When you create a report, you choose the data you want to display as well as how you want to display it. You can create table reports or free-form reports in the *Report Assistant*. You may also design a free-form report by choosing the Blank Report radio button in Report Assistant - Step 1. The characteristics of each type of report are listed below:

<table>
<thead>
<tr>
<th>Table Report</th>
<th>Free-form Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Displays data for a set</td>
<td>Displays data for a single company or group of companies</td>
</tr>
<tr>
<td>Presents data in columns and rows, with each with each company's data presented in 1 row</td>
<td>Labels and data can be anywhere in the report, or you can align the data into columns and rows</td>
</tr>
<tr>
<td>Automatically provides default labels for each column</td>
<td>You must add label cells and type labels for data</td>
</tr>
<tr>
<td>Displays Research Insight or user data</td>
<td>Displays Research Insight or user data</td>
</tr>
</tbody>
</table>

Displays subtotals

Displays summary statistics

• **Parts of a report**

Whether you create your own report, or use a pre-defined report, one or more of the following elements are found:

- **Cells**
  A cell is the intersection of every row and column, into which you paste or type a formula or label. In free-form reports, cells may appear anywhere in the report.

- **Formulas**
  A formula is an item, concept, function, or combination of, and can also include time periods, and relational and mathematical operators.

- **Labels**
  A label is the text that identifies data displayed in your report.

- **Tables**
  A table displays information in columns and rows. It provides you with a title cell to name your report, column labels, and formula cells.

• **Report Assistant**

The Report Assistant is designed to automate and simplify the steps needed for users to create custom reports for data viewing/output. The Report Assistant can be invoked via the Welcome Screen, the sidebar, the *Tools* menu, or from Step 3 of the Research Assistant.

In the *Report Assistant - Step 1* window you can begin building a custom report by defining your report parameters.

Define the time period - Research Insight gives you the option of creating a report for the Current Time Period (the most recently available data for the day, month, quarter, or year) or running a Historical Analysis report comparing data items and companies over a specified period of time.

Choose a report format - Select one of the radio buttons under *Current Time Period* or *Historical Analysis* to determine how items, companies, and time periods will display in your report. You will see a preview of the report format you choose in the Example window. If you choose a Companies vs. Items report format under Current Time Period, the Company Count box is enabled. You must then select the number of companies that will appear across the top of your report. You may also create a blank template and add/position your own cells by selecting the Blank Report radio button.

*Choosing the Items vs. Companies produces a Table Report in both scenarios. The remaining options produce Free-form reports, usually the most useful for displaying detailed information for one company record at a time.*
Keep in mind that “table” reports often run much faster than “free form” reports for generating data on large sets of companies.

After choosing your format, click Next to advance to the next window (Step 2) and choose the items that will appear in your report. The Report/Chart Assistant - Step 2 window is used to select items that you want to appear in your report or chart. For your convenience, data items are organized according to Item Groups (e.g. Valuation, Growth, etc.).

Click one of the radio buttons next to an Item Category. You will see that the Items list below changes to show all of the items that are available under that category.

Highlight an item in the list and click the Add button to select it for your report. The item appears in the Selected Items box on the right. If you decide not to include a selected item in your report or chart, highlight the item and click the Remove button.

You can arrange Selected Items in the list in the order you would like them to appear in your report or chart. To do this, select a listed item and change its position in the list with the Move Up or Move Down button.

Additional items and functions can be added to your report or chart by entering the mnemonic in the New Item text box. Then click the down arrow button to add that item to the Selected Items list. If you don’t know the mnemonic, click the Look Up button to search for items and functions.

You can also customize the Item Categories to include the items that you use most often.

After you have chosen the items for your report or chart, if you chose a Historical Analysis report, click Next to advance to the next step in the Report or Chart Assistant. If you chose a Current Period report, click Finish to run your report or chart.

The Report/Chart Assistant - Step 3 window appears only when you have chosen a Historical Analysis report or chart. It allows you to select a time period format as well as the beginning and ending time periods. It also lets you align items with different periodicities so that they appear on the same basis.

Select one of the three Time Period Formats - Relative for the year, quarter, month, week, or day relative to the current period; Absolute for the exact year, quarter, month, week, or day; or Calendar for a calendar year, quarter, month, week, or day.

Use the arrow buttons to choose the Beginning Period and the Ending Period for your report or chart. The following are some examples of beginning and ending periods for each time period format:

<table>
<thead>
<tr>
<th>Beginning Period</th>
<th>Ending Period</th>
<th>Time period returned in your report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relative</td>
<td>-1Y</td>
<td>0Y</td>
</tr>
<tr>
<td></td>
<td>0Y</td>
<td>If the current year (0Y) is 1997, the report returns 1996 and 1997. The current period differs among companies. It depends on when the latest update was done and on the company’s fiscal year-end.</td>
</tr>
<tr>
<td>Absolute</td>
<td>Y96</td>
<td>Y97</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Returns data for fiscal 1996 and 1997. If the company has a June fiscal year-end, the years run from Jul95 to Jun96 and Jul96 to Jun97.</td>
</tr>
<tr>
<td>Calendar</td>
<td>C96</td>
<td>C97</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Returns data for 1996 and 1997, January through December.</td>
</tr>
</tbody>
</table>

Choose one Alignment for each data item/periodicity in the report or chart. For example, if you selected a data item with an annual periodicity (like Sales) and an item with a monthly periodicity (like Market Value-monthly), then the annual and the monthly alignment options will both be enabled. If you choose monthly, then Research Insight calculates the annual item on a monthly basis, and returns a monthly Sales figure as well as the monthly Market Value.

Users may want to use period reference functions in their formulas, allowing the ability to change the time period associated with an item. For example, if you can change the time reference for a monthly item to a quarterly time period using the @MNT function such as PRCCM@MNT(0Q). Other period reference functions are: @DAY - Identify period day, @PERIOD - Display period number, @QTR - Identify fiscal period quarter, @WK - Identify period week, @YR - Identify fiscal period year.
• “Panel” Report and other User-defined Formats (for SAS, SPSS, etc.)

◊◊ Annual, Quarterly and Monthly “Panel” reports have been added to the Research Insight (North America) library of reports under the “Miscellaneous” folder. Research Insight also provides a “Report Assistant” for users who prefer to create their own report formats for exporting data into ASCII files. A free-form report gives the user more control over the basic layout of the report for such applications, but table reports are usually “faster” in generating and saving data for large sets of companies. Free form reports, by default, generate one record per company in the same file. In the case of spreadsheet software, such as Excel, the records will appear one after another in subsequent rows of your spreadsheet (Any labels included in the report will be duplicated between records, so many users choose to add labels after saving the data).

◊◊ Include the item GVKEY with any reports, in addition to TIC or CUSIP, as this is a permanent company identifier for Research Insight companies.

• Free Form “Panel” Reports

The following are two possible methods of creating a free form “panel” report. Method 1 potentially requires more keystrokes and manipulation than Method 2, in that the user is required to create and align every cell into rows and columns. Method Two automates the creation of rows and columns and formula creation/input, but the user may end up deleting some labels and cells to create a finished report (Faculty may prefer using Method Two, or creating a “table” format as described on page 20). Begin in the Report Assistant - Step 1 window.

Method 1

Selecting the Blank Report radio button, then selecting the Finish option will provide a blank report template. The user must then select either the “@” or “T” toolbar options to add/position formula or text cells. Once the cells have been added, input the formula or label for the respective cells. Be sure to take advantage of the copy, paste, and Edit/Replace... features of the software to minimize keystrokes and effort. You may also copy/paste rows/columns from existing reports and later change data and time references.

Method 2

Define the basic layout for your report by selecting the radio button Items vs. Time for a Company or Time vs. Items for a Company in the Historical Analysis box. This choice defines whether you have items/time periods going vertically or horizontally in the finished report. After choosing your format/parameters, click Next> to advance to Step 2 and choose the items that will appear in your report. You can choose multiple items as in the following example, or select a single item then use the copy, paste and find/replace functionality of Research Insight to add additional cells and items. Once you have chosen your items, click Next> to proceed to Step 3 and select the time periods for which you need data. At this stage, clicking Finish will bring up the Run Assistant window. Click Cancel to remain in the template without processing.

You can now delete extraneous items that you do not want, such as company name and labels, and modify as in Method 1 (i.e. using copy, paste and find/replace). The following is an example of using the Report Assistant simply selecting the annual item Sales, Net Income and Pretax Income for a five-year period.

![Diagram]

Above: Results of using Report Assistant, Items vs. Time for a Company, and selecting Sale for 5 years of data.
Below: Highlight the cells to delete (exporting the data creates an ASCII file with each record following the previous). To highlight simply click on the “CONM” formula cell, hold your *Shift* key and click on the “Net Income (Loss)” label cell, then hit *Delete* key.

If you decide that you want additional items or years, use the copy, paste and Edit/Replace options within Research Insight to modify the report. The example below shows how to add a column for Earnings per Share (EPSPX), Global Vantage Key (GVKEY) to the end of the report above, once the extraneous cells have been deleted.

Above: After deleting unwanted cells, copy the “sale” column by a) highlighting the cells, b) choosing *Edit/Copy* then *Edit/Paste* from the menu (or use the toolbar copy and paste) and, c) use the *Edit/Replace* and *Replace Select* (so that only the highlighted cells are replaced) to replace Sale with the additional items you need.

Note that in the following example the last column contains the item GVKEY. This was not input using the Replace option, but instead just typed after highlighting the cells. This is because GVKEY is a “scalar” item and will not function with time references. Further, GVKEY is input several times simply for company / data identification and alignment of data once exported to a spreadsheet.
An alternate format for creating panel reports is to use the Report Assistant, choosing the default Current Time Period and Items vs. Companies as shown below. This format is often preferable when data is needed for large sets of companies as it does not require the program to access an entire company record, instead only accessing the items requested of that record. This can be beneficial in terms of “speed” of both generating and exporting the data requested. You may choose *“Historical Analysis” as opposed to “Current Time Period” to get multiple years of data in a single report. Some users have indicated that this *format creates problems for certain software packages, as it lists the items multiple times across the top of the report.

You must run this report multiple times to generate data for multiple years since it is defined to run for the “Current Time Period” only. Select the Report Time Periods folder, as shown below, to specify the period for which you would like to generate data.
Charts

Research Insight provides you with an extensive collection of pre-defined charts to help you bring your financial analysis to life. This collection includes the most commonly used charts for both the Compustat North America and COMPUSTAT (Global) databases. You may also create your own charts using the Chart Assistant. This powerful tool will guide you, step by step, through the chart-building process. And, if you only want to chart a few items from your report, you can do that too.

Once you have selected the data you want to display and determined how you want to display it, you can customize your chart attributes. You can change the chart style, colors, and axis labels. You can also add titles, change fonts, and customize the legend. You can even change a two-dimensional chart to a dynamic three-dimensional chart. The possibilities are endless!

Charts are actually created via the Chart Assistant in much the same way as are reports via the Report Assistant. For detailed information regarding charts please refer to the Research Insight program help facilities. One thing to keep in mind is that once you have created a chart within Research Insight, clicking on the camera tool in the upper right corner copies the chart to the clipboard. Once in the clipboard, it may easily be pasted into other programs/documents such as Word, Excel and PowerPoint.

Related Topics in Research Insight:
- Creating a Free form Report
- Creating a Table Report
- Working with Tables
- Using Cut, Copy, and Paste in Reports
- Inserting and Deleting Columns and Cells
- Adding a Formula to a Report
- Customizing the Appearance of Your Report
- Running, Printing, and Exporting a Report
- Viewing report results for multiple companies
- Choose a chart style
- Changing your chart attributes
- Changing your chart criteria
- Creating a Chart From a Free-Form Report
- Working with charts in Excel
Sample Applications - Putting it All Together

Using the information presented earlier in this document, the big picture is essentially very simple. Research Insight is used to query and/or generate data for companies and industries. You may screen the database using either the Research Assistant or Classic View options to define your company or set, import companies to create your set, or simply enter tickers when prompted. Data is then generated via user-defined reports or picked from the extensive report library, and can be printed or saved to an ASCII file for use with spreadsheet or other software.

- Event Studies - Bankruptcy/Liquidation

The following serves as an example of an “event study” application for Research Insight…the occurrence of bankruptcy/liquidation for any given company in the database. Other events could be mergers/acquisitions, accounting changes, or dates of initial quarterly earnings reports. Regardless of the event, some marker or “flag” is required to identify the occurrence of the given event.

This example uses footnotes on specific data items to act as the flag needed for identification of the event. For example a “TL” footnote (or combination thereof) in items “ATF” or “ATQF” (annual and quarterly footnotes for the Assets - Total) indicates bankruptcy or liquidation. Users must first download the following files from our website (username & password required) at:

http://www.compustat.com/support/ri/private/ri_university.htm

<table>
<thead>
<tr>
<th>FILE NAME</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>BRUPT.TXT</td>
<td>File containing EVENT concepts for importing into your “user” database (see below).</td>
</tr>
<tr>
<td>BRUPT.SCN</td>
<td>Bankruptcy Event Screen to be run in “Classic View” to query database &amp; save sets.</td>
</tr>
<tr>
<td>EVNTABSF.RPT</td>
<td>Event Annual Balance Sheet with modified time references for application.</td>
</tr>
<tr>
<td>EVNTACT.RPT</td>
<td>Event Annual Cash Flow by Activity with modified time references for application.</td>
</tr>
<tr>
<td>EVNTAISF.RPT</td>
<td>Event Annual Income Statement with modified time references for application.</td>
</tr>
<tr>
<td>EVNTBQSF.RPT</td>
<td>Event Quarterly Balance Sheet with modified time references for application.</td>
</tr>
<tr>
<td>EVNTACTQ.RPT</td>
<td>Event Quarterly Cash Flow by Activity with modified time references for application.</td>
</tr>
<tr>
<td>EVNTISQF.RPT</td>
<td>Event Quarterly Income Statement with modified time references for application.</td>
</tr>
</tbody>
</table>

Follow the directions on the website to download the files, and then import the concepts EVENTA and EVENTQ from the BRUPT.TXT file into your local (CS5USER) or network (CS5NET) user database as follows:

1) Click the File option from the menu bar.
2) Next click the Import... option from the sub-menu.
3) Click the Concepts option in the lower right corner of the Import dialogue box.
4) Highlight the BRUPT.TXT file (downloaded from our website and saved to the Research Insight directory).
5) Click the Import option in the upper left corner of the Import dialogue box.
6) Click the Add All >> option in the Import Concepts dialogue box.
7) Click the Accept option in the upper right corner of the Import Concepts dialogue box.
8) Click OK when you get the message “Processing is Complete.”

You are now ready to use the bankruptcy event application. First run the BRUPT.SCN in the CLASSIC VIEW mode via the “Open Screen” button on the sidebar (listed as “Bankruptcy Event Screen” in the list of available screens). Be sure that your “Current Period Cutoffs” are set to the maximum values as specified on page 5.

The screen queries the SC and SR databases to identify companies that are, or have been, in bankruptcy or liquidation. The first two formulas (see below) of the screen query the database for bankruptcy footnotes on total assets (annual "atf", quarterly "atqf") across all periods. THESE FOOTNOTES ARE THE FLAGS THAT INDICATE THE EVENT, in this case bankruptcy. The formulas, or screening logic are as follows (using a “1” in the minimum column):

Line 1: @psum(@if(@or(atf="gl",@or(atf="tl",atf="ag")),1.0,0.0),-19,0)
Line 2: @psum(@if(@or(atqf="gl",@or(atqf="tl",atqf="ag")),1.0,0.0),-47,0)

Line 3 of the screen adds the two sets identified by lines 1 and 2, and names the set "events". Line 4 queries the "research" population (SR) for all companies whose reason for deletion is bankruptcy or liquidation. Line 5 looks for all NASDAQ companies with five-digit tickers ending in "Q", the convention used by NASDAQ to indicate bankruptcy.
Finally, Line 6 adds the sets from lines 4 and 5 to the "events" set to create a set (bnkrpts) of all companies either in or having been in bankruptcy. Lines 3 - 6 show other methods of identifying companies in bankruptcy. The resulting sets do not contain the flags needed for the event reports.

*The footnote may be on the annual or quarterly item, or both. If the annual footnote exists but the quarterly doesn't (or vice versa), the later respective report will not function properly. Also, the difference in the number of companies passing the annual/quarters screens is due to differences in the history of files (quarterly -12 years, annual-20 years).

Next, save the resulting company sets (EVENTA & EVENTQ) on lines 1 and 2 of the screen. These will be the *sets of companies to be run through the various reports supplied with this application. The set EVENTA should be used for the annual reports, whereas EVENTQ will be the set used for the quarterly reports. It is important to recognize that the existence of the footnotes IS REQUIRED in order to run the event reports. If there is no footnote the time-reference concepts (EVENTA & EVENTQ) and the reports will not function properly (i.e. You will see the same data for all five years of the report).

Note that the time referencing in the report formula above is modified from the standard “relative” references (i.e. [-1], [-2], etc.) to use the EVENTA concept. [EVENTA] refers to where the event actually occurs, [EVENTA+1] is one year after, [EVENTA+2] is two years after, and so on. An example with data is given below (the company was in bankruptcy in 1985):

<table>
<thead>
<tr>
<th>A I C IN TL INC</th>
<th>EVENT</th>
</tr>
</thead>
<tbody>
<tr>
<td>TICKER: 4225B</td>
<td>ANNUAL BALANCE SHEET</td>
</tr>
<tr>
<td>SIC: 5040</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ASSETS</th>
<th>Feb87</th>
<th>Feb86</th>
<th>Feb85</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cash &amp; Equivalents</td>
<td>0.467</td>
<td>0.581</td>
<td>0.104</td>
</tr>
<tr>
<td>Net Receivables</td>
<td>2.271</td>
<td>2.052</td>
<td>2.931</td>
</tr>
<tr>
<td>Inventories</td>
<td>2.480</td>
<td>2.495</td>
<td>4.749</td>
</tr>
<tr>
<td>Prepaid Expenses</td>
<td>@CF</td>
<td>@CF</td>
<td>@CF</td>
</tr>
<tr>
<td>Other Current Assets</td>
<td>0.186</td>
<td>0.167</td>
<td>0.168</td>
</tr>
<tr>
<td>Total Current Assets</td>
<td>5.404</td>
<td>5.295</td>
<td>7.952</td>
</tr>
</tbody>
</table>

Other footnotes/items can be used as flags. For example an “AA” footnote in “SALEF” or “SALEQF” to indicate a merger or acquisition, or the item Reported Date of Qtly EPS (RDQ). You can time reference items such as PRCCD[@day(RDQ)+1] to get the closing daily stock price on the day after the quarterly earnings report, or modify a report such as the quarterly income statement to replace “relative” time references with that of the RDQ date (i.e. SALEQ becomes SALEQ[@QTR(RDQ)].
• Backtesting

Did you ever wonder how companies with low valuations have performed over time? Do you have an investment theory that you want to see the performance of back in time? Research Insight provides an easy way to find the answers to these questions – and more – using the Excel backtest functionality.

With Research Insight, we’ve added backtest spreadsheets and an =SPWS_SCREEN function in EXCEL that allows you to backtest your theory and see which companies would have passed your investment criteria in previous years. This function takes a screen you have saved, runs it for a designated time period, and saves the companies that passed as a set. For example, you might use SPWS_SCREEN to create a set of companies that met your screening criteria as of Dec96. See Add-in functions under Research Insight Help Topics for more information.

Let’s say, for example, that you wanted to identify companies that meet the following criteria at year-end:

- Price is $50 or less
- Price to Earnings is 18 or less
- Price to Book is 1.5 or less
- Price to Sales is between .2 and 1
- Market Value is greater than or equal to $250 million

Your first step would be to create and save a screen in Research Insight based on the above criteria. There is just such a screen in the Research Insight pre-defined screen library called Backtest Monthly (BTM.SCN). There you will also find Backtest Quarterly, or you may create your own custom screen. In our example, we used the Classic View feature in Research Insight, but you can also use the Research Assistant to achieve the same results. If you create a new screen, you would first need to save it before proceeding.

### Backtest Monthly screen in Classic View

To view the companies’ returns (assuming you bought and held them for a year) and test this theory for the past five years, open the Quick Backtest Monthly Model Report (BASICMNT.XLS) spreadsheet in EXCEL. This template should be located in the Research Insight/Excel/Excel8/Backtest folder. You may have to use the “F9” key on your computer to initiate the calculation of cells.
Notice that the formula in cell B6 uses the =SPWS_SCREEN add-in function. To run this spreadsheet for your own screen, all you need to do is replace the screen “BTM.SCN” in cell D2 with your saved screen. The =SPWS_SCREEN function is used to create a set of companies based on a specific time period that you determine. Each set that is created is automatically saved in Research Insight and, for BTM.SCN, will begin with the characters $BTM (or whatever you’ve named your particular screen).

Comparing the results of our test, it appears that using the criteria we selected for our screen, we could have beat the S&P 500 in three of the past five years, and equaled it in a fourth.

To view the set of companies passed your screen for a specific year, click the one of the sheets labeled SET1 through SET6 tab at the bottom of the workbook, or one of the sets specified in cells B6 through B11. Note that the =SPWS_SCREEN function will always begin your set names with the characters $BT (e.g. SBTDEC94). The spreadsheet now displays all of the companies in the specific set, as shown below.
The BASICMNT.XLS spreadsheet and the =spws screen function are just two of the exciting new features waiting for you in Research Insight. Look for other custom templates located in Excel/Excel8 such as ZSCORE.XLS, DUPONT.XLS (both shown below), SNAPSHOT.XLS, ANALYZE.XLS and more. Use the S&P/Open Template menu option on the EXCEL menu bar for easy access!

HEWLETT-PACKARD CO

HWP
SIC: 3570 COMPUTER & OFFICE EQUIPMENT
Fiscal Year End: 98

| Price | ROA X | Leverage | 1-TAX Rate | Book Value Per Share | EPS
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Year 1</td>
<td>Year 2</td>
<td>Year 3</td>
<td>Year 4</td>
<td>Year 5</td>
<td>Year 6</td>
</tr>
<tr>
<td>1995</td>
<td>1.55</td>
<td>1.45</td>
<td>1.55</td>
<td>2.05</td>
<td>3.55</td>
</tr>
<tr>
<td>1996</td>
<td>1.45</td>
<td>1.44</td>
<td>1.45</td>
<td>2.04</td>
<td>3.45</td>
</tr>
<tr>
<td>1997</td>
<td>1.35</td>
<td>1.34</td>
<td>1.35</td>
<td>2.03</td>
<td>3.35</td>
</tr>
<tr>
<td>1998</td>
<td>1.25</td>
<td>1.24</td>
<td>1.25</td>
<td>2.02</td>
<td>3.25</td>
</tr>
<tr>
<td>1999</td>
<td>1.15</td>
<td>1.14</td>
<td>1.15</td>
<td>2.01</td>
<td>3.15</td>
</tr>
<tr>
<td>G999</td>
<td>1.05</td>
<td>1.04</td>
<td>1.05</td>
<td>2.00</td>
<td>3.05</td>
</tr>
</tbody>
</table>

DUPONT.XLS

Z-Score Calculator

Enter ticker here: HPQ
Enter Year here (ex: Y97): Y98

<table>
<thead>
<tr>
<th>Ratio</th>
<th>Formula</th>
<th>Weight Factor</th>
<th>Weighted Ratio</th>
<th>KEY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Return on Total Assets</td>
<td>-0.006</td>
<td>3.3</td>
<td>-0.019</td>
<td>Above 2.99---Healthy</td>
</tr>
<tr>
<td>Sales to Total Assets</td>
<td>1.409</td>
<td>1.0</td>
<td>1.407</td>
<td>Between 2.99 and 1.81---Warning Signs</td>
</tr>
<tr>
<td>Equity to Debt</td>
<td>1.544</td>
<td>0.6</td>
<td>0.926</td>
<td>Below 1.81---Could be headed toward Bankruptcy</td>
</tr>
<tr>
<td>Working Capital to Total Assets</td>
<td>0.342</td>
<td>1.2</td>
<td>0.410</td>
<td></td>
</tr>
<tr>
<td>Retained Earnings to Total Assets</td>
<td>0.671</td>
<td>1.4</td>
<td>0.939</td>
<td></td>
</tr>
</tbody>
</table>

CUBIC CORP

This Year's Score: 3.68 Indicator: Healthy

Last Year's Score: 4.88 Indicator: Healthy

ZSCORE.XLS

For additional information regarding Standard & Poor's Investment Services products and services for the university, please visit our web site at http://www.compustat.com/support, or refer to Other Compustat Products in the Research Insight Help menu option.